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Build Systems

A build system is a system that manages the process of delivering software.
This includes compilation, linking, testing, packaging and any other required
steps. Build systems have become more complex and capable over time.

* e.g., Maven for Java; Cargo for Rust; Cmake/Scons/Bazel for C++.

Characteristics of a useful build system:

* |t provides consistency in builds and build results.

* |t is expressive so that you can define any custom tasks e.g., zip a file.
* You can automate the build process to avoid user errors.

* |t integrates with other systems so that you can delegate responsibility
* e.g., remote test under a different OS.



What is Gradle?

Gradle is a modern build system for Java/Kotlin.

* It's popular in the Kotlin and Java ecosystems, used for Android projects.
* It's cross-platform and programming language agnostic.

* It's open source and has a large community of users.

Three main areas of functionality:
1. Managing build tasks: Manage build tasks e.g., compile and link, run tests.
2. Build configuration: Define and manage how these tasks are executed.

3. Dependency management: Manage external libraries and dependencies.



Getting Started

Gradle project structure



[ NON
Q
New Project
O Java
[X Kotlin
Groovy
C3 Empty Project

Generators
M Maven Archetype
8 JavaFX
® Quarkus
J Micronaut
4 Jakarta EE
4 Ktor
X Kotlin Multiplatform
B HTML
React
ex Express
x4 Android
¥ Vue.js
V Vite
o Nuxt

3 Multi-module Project

More via plugins...

? Cancel

New Project

Name: untitled

Location: ~/Downloads

Project will be created in: ~/Downloads/untitled

Create Git repository
Build system: | IntelliJ Maven Gradle
JDK: [ azul-21 Azul Zulu 21.0.7 - aarch64
Gradle DSL: Kotlin Groovy
Add sample code

To create a Kotlin Multiplatform project, click here 7

> Advanced Settings

Gradle is bundled with IntelliJ IDEA.

To create a Gradle project:

1. Use the Project Wizard'.

2. Select "Gradle for your Build

system.

w

4. Click "Create’.

See the course website:

Reference > Programming
> Create a Gradle Project

Select "Kotlin™ for your Gradle DSL.


https://student.cs.uwaterloo.ca/~cs346/1259/reference/programming/gradle-project/

Basic Project Structure

— build.gradle.kts

— empg{-iml build.gradle.kts is the main config file.
— Jgradtie
wrapper empty.iml is the Intelli) config file.

— gradle-wrapper.jar
— gradle-wrapper.properties

gradle: contains gradle wrapper config.

— gggg%gwpf‘ope"ties gradlew & gradlew.bat are scripts.
— gradlew.bat settings.gradle.kts is a top-level
— 2|‘§’;t1n95-9"ad19-kt5 project config file.
— main _ src: contains source code
B ll(o—ﬂﬁgin ot } source code « src/main/kotlin code module
L resources « src/test/kotlin unit test module
— test
— kotlin

—— resounrces



Build Tasks

How to execute Gradle tasks.



Gradle Tasks

Tasks are built-in commands that you can run,
that are specific to your project.

They can be executed either:
* From the command-line
* From the Gradle menu in Intellij IDEA

Command gradle tasks, run from the
command-line:

$ ./gradlew clean

$ ./gradlew build

$ ./gradlew run

Gradle

o e &+ B R 1z
v £7 demo
> (g Tasks
v &7 composeApp
v [ Tasks
> (@ android
(3 binaryen
(a build
(@ compose
(@ compose desktop
€3 checkRuntime
£33 createDistributable
£33 createReleaseDistributable
£33 createRuntimelmage
3 flattenJars

<>

AV VAV

<

In IntelliJ IDEA: View > Tool Windows > Gradle

><



Gradle Wrapper

At the top-level of your project's directory structure are two scripts:
« “gradlew for Unix users, and
« “gradlew.bat’™ for Windows users

These are Gradle wrapper scripts. You can use them to run Gradle tasks
without having to install Gradle on your machine.

e Pass them command-line arguments.

* The scripts will download Gradle for you, install it, and then run the
commands using that version of Gradle.

$ ./gradlew build

Is this a good idea? Why not just install Gradle manually?



Plugins

e Gradle comes with a small number of predefined tasks. You can
add additional tasks to your project as plugins.

* A plugin is a collection of related tasks that have been bundled
e ‘java plugin - adds language support, and
e "application” plugin - adds support for running a console app.

You add other plugins in your build.gradle.kts file.

plugins {
application
kotlin("jvm") version "2.0.10"

}
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Build Configuration

How to manage your build configuration.



Config files

— build.gradle.kts
— empty.iml
— gradle
wrapper

— gradle-wrapper.jar
— gradle-wrapper.properties
— gradle.properties
— gradlew
— gradlew.bat
— settings.gradle.kts
— src
— main
— kotlin

L — Main.kt
— resources
— test
— kotlin
— resources

build.gradle.kts - module specific

* It is possible to have multiple modules
(e.g., app/, service/). Each of these
would have its own build.gradle.kts
file specific to that type of module.

* This example has a single module, at the
root.

settings.gradle.kts - project level.

* It contains settings that apply to all
modules.



settings.gradle.kts

This is the top-level configuration file. You don't need to modify
this for single-target projects.

// 1list any plugins that you want to use across all modules
plugins {

id("org.gradle.toolchains.foojay-resolver-convention") version "0.5.0"
}

// top-level descriptive name
rootProject.name = "project-name"

settings.gradle.kts
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build.gradle.kts

This is the detailed build

configuration. Modify it to:
* Add a new dependency (i.e. library)
e Add a new plugin (i.e. custom tasks)
* Update the version number of a

product release.
* Don’t expect to create the
perfect config file right-away.

 Start with the one generated by
Intelli) IDEA.

* Modify as you add dependencies or
make changes.

// needed for desktop
plugins {

kotlin("jvm") version ”2.0.10"
}

// product release info
group = "org.example"
version = "1.0.0"

// location to find libraries
repositories {
mavenCentral()

hy

// add libraries here
dependencies {
testImplementation( org.jetbrains.kotlin:kotlin-test")

hy

tasks.test {
usedUnitPlatform()
}

// java version
kotlin {
jvmToolchain(21)

build.gradle.kts




Dependencies

How to manage project dependencies.



What are dependencies?

In this context, dependencies are external libraries to provide functionality
e.g., networking, user interfaces.

* They need to be downloaded and added to your project to be useful.

A large challenge of any build system is managing these dependencies. i.e.,
* Making sure that you have the correct version of a library,
* Including dependencies that library might need (called transitive dependencies).

* Making sure that the library is compatible with the rest of your software, and that it
doesn't introduce any security vulnerabilities.

* In Gradle, you specify your dependencies in your build scripts.
* Gradle will download them from an online repository as part of your build process.



Finding dependencies

* You can search Maven Central or use a package manager like this klibs.io.
e Pay attention to supported platforms: does it work on your platform?

Klibs.io*

to search 2200 KMP projects

All (2547) Compose Ul (47) Dependency Injection (21) Utility (20) Test (17) Storage (14)

okhttp *46.5k

by square

Efficient HTTP client enables faster loading and reduced
bandwidth through HTTP/2 support, connection pooling,
GZIP compression, response caching, and robust.

WA Apache License 2.0

2& Android JVM, JVM, JS, Common

ktor *13.8k

by ktorio

Create asynchronous client and server applications.
Anything from microservices to multiplatform HTTP client
apps in a simple way. Open Source, free, and fun!

N Apache License 2.0

@ iiNetwork, #Web, #HTTP

28 JVM, Kotlin/Native, Wasm, JS, Common

compose-multiplatform *17.9k
by JetBrains

Facilitates sharing Uls across iOS, Android, Desktop, and
Web using a declarative framework. Provides high-
performance Ul rendering, native APIs access, and...

N8 Apache License 2.0

L4

28 Android JVM, JVM, Kotlin/Native,

ompose Ul, #Jetpack Compose

S, Common

kotlinx.coroutines *13.4k
by Kotlin

Enables asynchronous programming with lightweight
coroutines, offering structured concurrency, cancellation,
and integration with various reactive streams and Ul

N Apache License 2.0

& #hsynchronous, #Concurrency.

28 JVM, Kotlin/Native, Wasm, JS, Common

Report an issue  FAQ

KMP projects Filter

Network (13) Ul (13) See all (5)
mirai *14.8k
by mamoe

High-efficiency library for creating QQ bots, supporting
various message types (text, images, voice, etc.), group.
management, and synchronization with other clients. Ope.
W GNU Affero General Public License v3.0

@ #50t, #Chatbot, #Asynchronous, #Messaging

Android JVM, JVM, Common

coil *11.4k

by coil-kt

Image loading library of coil zed for Android apps, featuring
memory and disk caching, minimal boilerplate, and
integration with modern libraries. Supports ImageView an
N# Apache License 2.0

#

28 Android JVM, JVM, Kotlin/Native, Wasm, JS, Common

hics, #lmage, #Network

(/] to search 2200 KMP projects

Readme  Packages

s COIL

Animage loading library for Android and Compose Multiplatform. Coil is:

pausing/cancelling requests, and more.

Coil is an acronym for: Coroutine Image Loader.

Translations: H v, $1201, Pycckuii, Svenska, Tirkge, F132

Quick

Import the Compose library and a networking library:

implementation("io.coil-kt.coil:
implementation("io.coil-kt.coil

oil-compose:3.1.0")
oil-network-okhttp:3.1.8")

Fast: Coil performs a number of optimizations including memory and disk caching, downsampling the image, automatically

Lightweight: Coil only depends on Kotlin, Coroutines, and Okio and works seamlessly with Google's R8 code shrinker.
Easy to use: Coil's AP! leverages Kotlin's language features for simplicity and minimal boilerplate.

Modern: Coil is Kotlin-first and interoperates with modern libraries including Compose, Coroutines, Okio, OkHttp, and Ktor.
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https://klibs.io/

Adding Dependencies

You add a specific module or dependency by adding it into the dependencies
section of the build.gradle.kts file. Dependencies need to be specified
using this syntax:

group-name: module-name: version-number

We can often copy and paste the dependency line from the package
information page directly into our build.gradle.kts

dependencies {
implementation("io.coil-kt.co0il3:coil-compose:3.1.0")
}' | Y ) | Y ) \ )

group-name module-name version




Version Catalogs

* One challenge to using a lot of dependencies is keeping track of the
versions of libraries that you are using.

e Gradle has a feature called version catalogs, which is a centralized
file that contains a list of libraries and their versions.

* Gradle will automatically keep versions up-to-date using this file.

* In Gradle 7.x or later, the version catalog is contained in a
file libs.versions.toml in your gradle/ project directory.

* You use the dependencies defined in the version catalog in your build
config files.

https://docs.gradle.org/current/userguide/version catalogs.html



https://docs.gradle.org/current/userguide/version_catalogs.html
https://docs.gradle.org/current/userguide/version_catalogs.html
https://docs.gradle.org/current/userguide/version_catalogs.html
https://docs.gradle.org/current/userguide/version_catalogs.html
https://docs.gradle.org/current/userguide/version_catalogs.html
https://docs.gradle.org/current/userguide/version_catalogs.html

gradle/libs.versions.toml

[versions]
guava = "32.1.3-jre"
junit—-jupiter = "5.10.1"

[libraries]

guava = { module = "com.google.guava:guava", version.ref = "guava" }
junit—-jupiter = { module = "org.junit.jupiter:junit-jupiter",
version.ref = "junit-jupiter" }

build.gradle.kts

dependencies {
// This dependency is used by the application.
implementation(libs.guava)
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Types of Gradle projects

Getting started with a new project.



Single Project Structure

The top-level module is defined in the root of the project.

build.gradle.kts
src
main
kotlin
resources
test
kotlin
resources

%Eidle
wrapper

gradle-wrapper.jar
gradle-wrapper.properties
gradlew
gradlew.bat
settings.gradle.kts

Configuration files are at the top-level.
Source tree is also at the root.

This is a single module, loosely defined.

IntelliJ: New Project > Kotlin

Build system: Gradle
Gradle DSL: Kotlin
Generate multi-module build: unchecked
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Multi-Project Structure

A “better” structure moves the source code into multiple modules.

— app/
build.gradle.kts
src

main

l: kotlin
resources

test

kotlin
resources
gradle/
gradlew
gradlew.bat
settings.gradle.kts
util/
build.gradle.kts
src

main
kotlin
resources
test
kotlin
resources

‘app is the first module.
‘util” is a second module.
e build.gradle.kts is specific to each module.

Why 2 modules?

« Different platforms e.g., android, jvm

» Different purposes e.g., one could be
published as a library, the other as an app.

IntelliJ: New Project > Kotlin

Build system: Gradle
Gradle DSL: Kotlin
Generate multi-module build: checked
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KMP Project Structure ek

— build.gradle.kts

. —— SI'C
The project breaks down the source code | androidMain
into two main projects. — commonMain
i —— desktopMain
e composeApp includes all Compose code. It | josMain
is further split into android, common, — grag{e Ny
. —— gradle.properties
desktop and iOS. | FosApp
* This is where you add source code. — Configuration
. _ _ , L— Config.xcconfig
* iosApp includes the iOS project and ___ i0sApp
configuration files, used to build and — éSSGtS-CC_aSSGtS,f
package using Xcode and other macOS : I;’?geg{igiw'sm t
tools. . Preview Content
* Integration point for Kotlin/iOS. — 105App. swift
) ) —— 10SApp.xcodeproj
* You probably shouldn’t touch this! L project.pbxproj

— local.properties
IntelliJ: New Project > Kotlin Multiplatform settings.gradle.kts
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Instruct

eC e

Q

New Project

T Java

[X Kotlin
Groovy

Ca Empty Project

Generators
m Maven Archetype
B JavaFX
(® Quarkus
M Micronaut
4 Jakarta EE
4 Ktor
X Kotlin Multiplatform
B HTML
React
ex Express
# Android
Y Vuejs
V Vite
2 Nuxt

3 Multi-module Project

More via plugins...

?) | Cancel

ions: How to create a Gradle project

New Project

Name: untitled

Location: ~/Downloads
Project will be created in: ~/Downloads/untitled

Create Git repository
Build system: | IntelliJ Maven Gradle
JDK: (G azul-21 Azul Zulu 21.0.7 - aarch64
Gradle DSL: Kotlin Groovy
Add sample code

To create a Kotlin Multiplatform project, click here 7

v Advanced Settings
Gradle distribution: | Wrapper v
Gradle version: 8.14 v Auto-select
Use these settings for future projects
Groupld: ca.uwaterloo

Artifactld: untitled

[ NON J

Q

New Project

@ Java

X Kotlin
Groovy

C3 Empty Project

Generators
m Maven Archetype
8 JavaFx
[ Quarkus
L Micronaut
4 Jakarta EE
% Ktor
X Kotlin Multiplatform
B HTML
React
ex Express
= Android
¥ Vuejs
V Vite
2 Nuxt

3 Multi-module Project

More via plugins...

? Cancel

New Project
Name: demo1
Location: | ~/Downloads

Project will be created in: ~/Downloads/demo1

Create Git repository
Group: ca.uwaterloo
Artifact: demo1

JDK: (G azul-21 Azul Zulu 21.0.7 - aarch64

Android

With Compose Multiplatform Ul framework based on Jetpack Compose
i0s
Ul Implementation Share Ul Do not share Ul

With Compose Multiplatform Ul framework, or use SwiftUl

Desktop

With Compose Multiplatform Ul framework

Web

Ul Implementation Share Ul Do not share Ul

With Compose Multiplatform Ul framework, or use React

Server

With Ktor 7 framework

Include tests

Ear o lict nf camnla nraiante can Tamnlata Qallans 2

Reference > Programming > Create a Gradle Project
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